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Abstract. When researchers take their first steps in qualitative research, they face
the great lack of models to follow regarding the method to use in the analysis of
data, on some occasions falling into the temptation of coveting the high level of
systematisation employed by researchers working with quantitative data. This
article offers a basic theoretical contribution that allows researcher to approach
qualitative data analysis and the use of the NVivo software, highlighting its
advantages and describing the main functions at each moment of a qualitative
investigation, placing particular emphasis on the analysis process.
Keywords: NVivo; software use; qualitative methodology; data analysis;
analysis process.

1 Introduction
CAQDAS NVivo - from a holistic perspective - not only provides help in information
or data analysis, its usefulness covers the entire process of a qualitative investigation.
From a very generic point of view, qualitative research can be understood as “localised
activity in a certain place and time that situates the observer in the world” [1, p.48]. Its
intention is to make the world visible thanks to interpretive practices and the use of a
series of materials that are going to be particular to it such as observation, narration,
interviews and the analysis of textual, digital or audiovisual documents. Furthermore,
its habitat or research context will be natural settings, which involves us approaching
the phenomenon that is the object of our study with an open vision, attempting to
interpret them from the very words and actions of the people participating in the
research process.
The open view previously described means that researchers may be moving in a wide
spectrum, allowing the coexistence of paradigms within it that can go from the positivist
or post-positivist, based on Grounded Theory and deductive logic, which will situate
its narrative in the mould of the scientific report, to the socio-critical, represented by
many sides, but all of them identifying critical theory as a foundation of a type of report
removed from the scientific model, and which may become expressed in the form of an
essay, story, fable, historical, economic or sociocultural analysis, or autobiography [2].
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With this panorama described in mind, perhaps the question that we would have to
ask is whether CAQDAS NVivo is able to provide an answer to the wide diversity
described or whether, on the contrary, it is not designed to respond to all of them. The
answer is easy: the software is simply a tool put at the disposal of researchers. It doesn’t
determine or obstruct the paradigm or methodology along which we move. This
decision will always depend on the researcher, based on the ideological,
epistemological, ontological and methodological position, but not forgetting that
qualitative methodology normally occurs when multiple methods are employed to [3],
[4] search for a better understanding of the phenomenon that is the object of our study.
More than a tool, CAQDAS NVivo is a complete bank of work put at the disposal
of the “qualitative bricoleur”. This concept, widely used in the field of qualitative
research [5]–[7], offers us an extremely graphic idea of the versatility with which
researchers can move when carrying out their work. The availability of an excellent
bank of work is not a guarantee of success. The true guarantee of its quality will be the
artisan who, with wisdom, will have known how to select the appropriate tool from the
bank to carry out his work. What we can guarantee is that we are facing software which,
in good hands, can help us greatly in our investigative process.
If we specify that which has been put forward to this point, we find that, when facing
a qualitative investigation, we will have to opt for one tool or another depending on the
point of the paradigmatic spectrum where we are situated, and despite being at risk of
not being able to include the multitude of tendencies and focuses that could arise, we
can identify four important tasks to carry out:
1. Research design. The researcher must contextualise the experience to be
studied. It is the moment to decide the most appropriate methodology and affirm
our beliefs on the basis of the paradigm that sustains us.
2. Data production and analysis. It will be the task par excellence of the researcher,
tackled from the rigorousness of a selective display or from the amplitude that
allows us to initiate production from an informant or key context. It will be
possible to adopt an inductive, deductive or mixed focus. The end point will be
to achieve the understanding of the phenomenon studied, affording it visibility.
3. Identification of existing theories. Prior theories may determine the production
of data or theories gathered from the inductive production and analysis. In both
cases other versions of the phenomenon that is the object of our study should
not be ignored.
4. Report construction. This last task is key in the process. The focuses can be
many and their production will be orientated based on the audience that the
report is aimed at. If we want to emphasise that the qualitative research is
understood as a process of improvement, the reports should be indebted to the
people who have participated in the process, independently of whether we can
also create reports to provide a response to audiences of a more academic and/or
scientific nature.
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NVivo in research design

Research design, as put forward by Cheek [8], should cause the researcher to become
aware of the context in which it is going to develop. Up to this point there was always
the myth that qualitative research could be carried out at low cost or with no funding
whatsoever, but the current reality tells us that all research requires funding for two
fundamental reasons: being able to cover the costs it implies, and promote the work
carried out. This necessity can mean we are obliged to sacrify our axiological and
methodological beliefs and approaches in order to adapt ourselves to the dominant
culture in the sphere of research.
Once this clarification has been realised (we recommend [8], p. 53-93), Denzin &
Lincoln [9] establish five levels of research and reflection when setting out the design
of an investigation:
1. Where is our paradigm of reference going to be in terms of the context, participants,
method, production techniques and data analysis? In short, the paradigm and the
process to follow must be specified for the sake of its consistency.
2. Are the materials (methods and techniques) going to be appropriate for providing
a response to the problems contemplated and the change we wish to produce?
From these two initial questions, the rest are going to open the door for us to the
social phenomenon that we are going to investigate.
3. What is our object of study going to be? Materialised in the queries (orienting
objects or possible hypothesis, according to our paradigm of reference) and the
people or phenomena that we will attempt to view from the investigation. This
question will be answered with a greater or lesser degree of flexibility, according
to our paradigmatic positioning. Situated in the positivist/post-positivist side, it
will be necessary to explain internal and external criteria of validity, and the
utilisation of sample selection techniques. If we place ourselves on the opposite
side, or the social-critical paradigm in any of its manifestations, where before we
found an absolute rigidity, now we enjoy maximum flexibility when carrying out
and putting into practice the design of the investigation.
The study object determines a perspective with which a phenomenon is tackled, and
as such, it is a problematic reasoning of reality, [10]. Analysing and studying reality
does not consist in the recollection of empirical data, rather, it is the construction of
data from a specific viewpoint, which is related to what has been denominated, that is,
the theoretical, political and ethical view and position, [11] which will be specified in
the principles of actuation and the methodological option.
4. What strategies are going to be appropriate to provide an answer to the object of
study? Before continuing, it is worth clarifying the difference between
methodology and method. The methodology is the philosophical framework or the
way of thinking and studying social reality, whereas the method is the group or
procedures and techniques for producing and analysing data [12], [13]. There are
a wide range of methods available to us and, from the coherence with the previous
reflections, we will have to opt for the one or ones that can provide us with the best
answer. We can become social or educational ethnographers; Case Study
researchers; interpreters of social phenomena in their multiple manifestations;
analysts of reality from logical-deductive strategies, applying Grounded Theory;
active participants of investigation focusing on action, technique or critique, or

focus ourselves on a clinical qualitative research model centred on the questions
that arise from daily practice different contexts, including health, education, and
social action.
With the previous matters answered, we reach the last question:
5. Which research tools or techniques are we going to select from our bank of work
to provide a response to the queries generated? We can basically group them into
four large areas: observational, documental, narrative and dialogical. On some
occasions it will be necessary to opt for one and on others a combination will be
necessary if our queries want to go further than knowing the what to look into the
how, where and why of our investigation. Quality is not always found in the
quantity or diversity of techniques or participants; sometimes we discover it in the
study of the singular, although it is translated into one participant and a single
technique. Excellent autoethnographies demonstrate it thus (we recommend [14,
p. 262-315].
Quivy & Van Campenhoudt [15], in their design proposal for a qualitative
investigation, open two basic demands for the tackling of this first step in our research:
self-reflection and the consultation of external sources.
How can the NVivo software help us in these two processes?
To begin the self-reflection process our first decision should be to create a new
NVivo project. This decision, which may seem obvious, is not usually made by the
majority of researchers, who consider the program to be exclusively a data analysis
tool.
From here, it is the moment to work with the internal sources, and within these we
have a key tool designed to gather together implicit beliefs and theories, both prior and
constructed throughout the process by the researcher; we are talking about memos,
which are still nothing more than editable text documents which allow us to collect all
reflections and notes that could be relevant to the investigation. The way of organising
them in different folders or subfolders is for the researcher to decide. To summarise,
we could say that memos would be the equivalent of the researcher's diary.
As a complementary tool to the memos, and seeking a better understanding and
comprehension of the social phenomenon we are going to study, CAQDAS NVivo within the Explore menu - supplies us with the mind and concept maps. In the first case
it helps us create, via a hierarchical and ramified structure, a conceptual scheme of the
design elements of our investigation. In the second case, we are able to generate a freely
designed map that is not necessarily hierarchical, in which original ideas and concepts
can be combined with elements already generated in our project (resources, nodes,
classifications, ...). This second possibility of creating deductive maps allows the
establishment of relationships and inferences between the ideas and queries of the
researcher, and the theories constructed by the participants, reflected in the categories
(nodes) created in the analysis.
Regarding the consultation of external sources, they can be produced in different
intensities based on the paradigm that supports the investigation. From positivist and
post-positivist approaches, it will be a key task to undertake upon starting our
investigation, and with a great degree of depth, as we will prioritise deductive over
inductive analysis processes. If, on the other hand, our investigation is framed within
the constructivist or socio-critical paradigm, the stress will be on the voice of the
participants, their theories and beliefs, to which, in this case, from the inductive

processes, the approach to already constructed external or formal theories will be
progressive and simultaneous with the emergence of the implicit theories of the
participants.
In both cases, CAQDAS NVivo offers us a series of tools that we are going to find
very useful for the documentation process. At this point we are going to focus on the
two most common which are currently at our disposal: paper and digital documents.
For the former, the tool available is the external, which is a bibliographical record of
those resources that cannot be included in our project as an internal. The externals are
going to be equivalent to the bibliographical records or summaries that are usually made
when we want to document a research project. The advantage is in the fact that, being
incorporated into the project, they are available for categorisation and codification in
the same way as any other resource (internal or memo).
In the event that the documental source is in digital format and is compatible with
the software, the possibilities for its management increase. In a logical, ideal situation,
the steps to carry out would be as follows:
1. Carry out a search for books, articles or any other document via the different
databases to locate relevant information on the topic that interests us.
2. Use any of the bibliographical reference managers available and which NVivo
subsequently recognises to import the information it generates (EndNote,
Mendeley, RefWorks and Zotero).
3. From the previous step, NVivo import all of the information generated,
organising it in the project automatically via the option of the Data, other
sources menu, selecting the management system used (EndNote, Mendeley,
RefWorks and Zotero).
Within the queries to external sources, Quivy & Van Campenhoudt [15] mention
the convenience of holding interviews with experts on the topic with the goal of
specifying it. These documentation interviews can be totally or partially transcribed
(only fragments of value) in CAQDAS NVivo. In this case, the recording should be
made in audio or video for the file to then be incorporated into the project file from the
option that it offered to us in the Data menu, and proceed to its transcription. If we do
not wish to lose the link to the audio or video file, we would have to create it as an
external; in the event that we are only interested in the interview text, we could
transcribe directly to a memo.
Lastly, with a view to a more in-depth reading of the texts, and seeking to make the
opinions, questions or theories of the researcher visible, we could use the link options
within the Analyze menu, and it should be pointed out that from these we can
incorporate notes in the texts analysed, which bring together ideas or reminders, “see
also” links to establish relationships between documents, hyperlinks to external files or
documents available on the internet and, finally, create links to memos with the
document that we are analysing. In figure 1 we can see a summary of the strategies that
can be used at this first design stage of the investigation.

Fig. 1. NVivo strategies in qualitative research design

3 NVivo in data production and analysis
How is data production and analysis carried out? In the arc that we drew at the
beginning of this article we saw how qualitative research moves in a wide paradigmatic
spectrum; the reality of the situation is that there are production and analysis focuses
that are very far apart and even opposing, despite sharing a single cohesive concept. If
we take a global approach to tackling the problem and, at the risk of being dichotomous,
we can start out from two models:
In the first, again taking the principles of experimental design of the Sciences, we
find ourselves before two clearly defined moments: data collection and analysis. The
qualitative investigations that are nourished by it normally identify some participants
(really a sample), intentionally selected, which looks for representation. It is frequent
to observe in the designs an initiation from previous theories, making the act of data
production the purely mechanical act of creating a preset number of observations,
interviews, focus groups and any other information collection technique. That is, the
stress in deduction rather than induction, and there is usually preference for an analysis
that tends to work from the particular, depersonalising the participants, in order to
generate or test a general theory.
In this second model, we can see that it is the singular that is important, the
participant, from whom we will construct the substantive theory from his or her own
implicit theories. The start of the data production is generated from a key informant.

The process is transformed into a productive spiral, fed back from an exercise of
constant to-ing and fro-ing from analysis to production. This constant game which, as
in the Moebius strip, never has a beginning or end, will stop when the researcher decides
that the knowledge generated on the social phenomenon studied is sufficiently relevant
to take the context as saturated (see figure 2).

Fig. 2. Process of analysis in an emerging qualitative research design

What can NVivo contribute to facilitate data production and analysis to the
researcher? (See figure 3) Economy, credibility and quality of our investigation.
Economy, because it facilitates the most arduous tasks of qualitative research,
especially the identification of central categories and subcategories, and their
subsequent codification. It is convenient to unify concepts to avoid confusion. The
software identifies the category as a node. This concept is more appropriate for as, as it
breaks the classic linearity, and encourages working from the reconstruction of the
discourses, by way of the weaving of a network. In this way, we can habitually read
how the codification assimilates the indexing concept, used more in the sphere of the
digital network and understood as the incorporation of content to an index (nodes). As
well as these tasks, it will allow us to carry out specific text searches, classify the
participants, assign attributes, construct framework matrices that facilitate discourse
analysis, etc.
The second contribution is credibility. One of the main criticisms aimed at
qualitative research is its lack of rigour in analysis processes. It is frequent to see how
in a report the methodological path carried out is not shown, in many cases, a sensation
in which the reader does not know if the theories of the participants prevail, or the
specific view the researcher is makes of them. We are not ingenuous; asepsis in the
qualitative report does not exist, nor is it recommendable if we put forward that the
truth is polyhedral and depends on the angle from which it is observed. But from this
point to not leaving evidence of the analysis process carried out there is an abyss that
we cannot allow. This credibility can be made visible with CAQDAS NVivo through
the use of different query options such as matrix coding, coding, compound, word
frequency, etc.

The consultation strategies that are going to be employed will also depend on the
paradigm within which we are positioned in our investigation, and the method or
techniques we are using to produce the information.
Lastly, we will find the third contribution of the NVivo software in the improvement
of the overall quality of the investigation. We can still find, in the 21st century,
colleagues who defend the purity of qualitative research tooth and nail against the
attacks it is receiving from the world of technology. We simply have before us a tool
(we consider that in the face of all it is a work bank) and the decisions of how, when
and for what to use it will always be in the hands of the researcher.

Fig. 3. NVivo strategies in data production and analysis

What is evident is that a greater depth in the data produced, the possibility of
establishing relationships between the whats, the whys, the hows and the whens, the
possibility of growing the singular into the particular from the identification of
attributes, polishing the analysis from the construction of matrices or being able to carry
out a comparison of the discourses of the participants, leaving evidence from the
framework matrices, means an improvement in the quality of the investigation.

4 NVivo in the identification of existing theories
The critical stage in the creation of qualitative research reports occurs at the moment
when we have to move from the description of participants’ theories to their fusion with
the interpretation made by the researcher from them, constructing the substantive
theories of the investigation. We are used to linear reports which imitate the design of
an experimental report and respect its big moments, but which are camouflaged by the
qualitative terminology. Instead of the state of the question, on the majority of
occasions there is a non-critical superposition of the dominant theory in the field. From
this point, we move on to the exposition of a methodology that, on occasions, lacks
even modesty and maintains concepts such as sample, subjects, study variables,
research hypothesis; it is rare to find starting questions which, if they do appear, are
more often than not accompanied by objectives that are usually repetitions of the
former, defined from respect for established guidelines. The next step is to put forward
some results that, in general, are limited to a descriptive sequence of the categories,
constructed via the summation of a constant cycle of textual quotes followed by the
explanation of the researcher, which is saying the same thing with other words. There
is then a discussion, disguised as an interpretation of results, in which formal theories
put forward in the initial question stage cross with the substantive theories constructed
with the participants, to end with some conclusions that focus on the most significant
aspects of the investigation.
Against this model it should also be pointed out that there are excellent investigations
which, starting out from the questions and motivations that led to the beginning of the
study, open the range from a mixed analysis, in which substantive theories emerged
crossed with the dominant ones in the field, and an excellent incorporation of the paths
followed to reach the described destination. Notwithstanding, it must be said that these
are in the minority.
How does NVivo help us in this process? Putting at our disposal a wide range of
tools, which gives us the power to test the questions that will be generated throughout
the analysis process. We can generally find this range of tools in three spaces in the
program in the main menus: Analyze, Consult and Explore (see figure 4).
From the Analyze menu, once the main categories (nodes) have been examined, we
continue with categorisation searching for and establishing relationships (associative,
unidirectional or bidirectional) between these categories and analysing those that
CAQDAS NVivo calls feelings, which collect emotions or aspects that are very
positive, positive, negative and very negative in relation to the content of each node.
The Query menu opens all of the tools that allow us to carry out different search
strategies and matrix coding.
Lastly, the Explore menu provides us with the possibility of creating maps, which
can be mind maps, of projects maps or concept maps; the possibility of carrying out
approximations of visual analyses in the following formats: chart; hierarchy chart;
cluster analysis; comparison diagram and network sociogram. The only thing that the
software does not give us is creativity, imagination, intuition, curiosity and evidence
that all researchers need to undertake the deductive processes of the analysis.

Fig. 4. NVivo strategies in the identification of existing theories

5 NVivo in the creation of a report
Once this point has been reached it is complex to be able to go deeper without
reiterating the aforementioned points if we want to draw attention to the convenience
of the change of mentality that should operate in our community of qualitative
researchers. Despite this, as we mentioned in the previous section, we have taken the
clothes of experimental designs off. Few take risks, except in the field of anthropology,
to offer report proposals that are more coherent with the principles that govern the
qualitative. We understand and respect that the spectrum we operate in is wide, and in
many cases there are more discrepancies than agreements between researchers which,
in theory, we move in the same ecosystem as qualitative research. But it would be
necessary to start plotting out limits to the idea of “everything goes” as a report. Still
respecting that carrying out qualitative research contains a part of significant artistic
creation and that the type of reports is and should be diverse, we must start establishing
some minimum guidelines that strengthen the paradigm and afford it the credibility and
quality demanded of us from other fields of knowledge.
In this space CAQDAS NVivo provides us with the possibility of incorporating all
types of graphic images that facilitate the understanding of the processes carried out. In
addition, it permits us to generate maps, already mentioned, which serve to provoke a

more agile and quick understanding of the contributions made. Furthermore, its
complete compatibility with Office allows us, via copy and paste strategies, to be able
to bring any information produced with the program to our word processor or
spreadsheet. This path is bi-directional, to which it works perfectly in the opposite
sense. It also allows us to export reports in PDF format, or images that we can then
include in a document generated with the word processor, to create the research report.

6 Conclusions
Simplifying the possibilities of CAQDAS programs - especially NVivo - is one of the
most common errors of qualitative researchers, even leading to their denial from a
position that we could now label as classical. Denying the benefit of making use of the
technological advances that facilitate the qualitative research process is to take a
position of denial that is, today, sterile and useless, which would not permit us to make
advancements in the important aspects.
We should be very aware that under no circumstance do current CAQDAS programs,
especially NVivo, which we understand to be the most useful of those in existence,
attempt to substitute the researcher. The questions of the before and the during of the
investigation, access strategies and information production are functions that we cannot
delegate to the program. However, we do find within it the help that facilitates the
processes, the detailing of the analysis and the offering of the evidence that will give
the investigation a greater quality.
The software is simply a tool put at the disposal of researchers, and the uses and risks
that may exist around the use of information technology in qualitative research do not
originate from the nature of the program itself, rather from the attitudes of the
researchers; thus, NVivo conditions the ideological, epistemological, ontological and
methodological positioning of an investigation.
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